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1 General Information About Installation

1.1 Setup Program and Installation Instructions
The setup program installs the user interface MTGUI for the systems
MTC200, ISP200, and TRANS200.

The installation of the basic graphical user interface of the software and
firmware version 21VRS requires knowledge of working with PCs and
knowledge of the operating system Windows NT. Especially for the
optimization of the system, settings and adjustments are necessary. This
requires knowledge of the installing operating system. Administrator rights
are required for the installation.
⇒ We recommend that the installation is executed by an experienced

user with knowledge of operating systems and with administration
rights.

The installation program decompresses and installs the user interface
and the associated files from the CD ROM onto your hard disk. The
interface cannot be operated without this installation. Furthermore,
updating and uninstalling the software is possible.
⇒ Execute the setup program before using the interface.

This documentation informs you about how to install and set up the
interface on your hard disk and how to uninstall it.
⇒ Read these installation instructions and if necessary additional

documents before you install the software.

1.2 System Requirements

Hardware requirements
The user interface  of the software and firmware version 21VRS for
MTC200, ISP200, and  TRANS200 can be installed on the Rexroth
Indramat BTV20 operator panels and on most standard IBM compatible
PCs.
The following hardware requirements are expected:

Windows NT 4.0 Minimum Recommended
Processor type 233 MHz 366 MHz
Main memory 64 MB 128 MB
Display 640*480, 65535 colors
Hard disk 300 MB free space
CD ROM drive or
network

Floppy drive

for installation

for data backup, firmware update
Serial interface
(as an option)

For connection to MTC200-R-G2, ISP200-R-G2,
TRANS200

Fig. 1-1: Hardware requirements

What is going to be installed?

Who installs the program?

Setup Program

Documentation
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For the installation on a PC, at least 2 slots must be available.

Note: TRANS200: There are no slots required for the TRANS200.

Depending on the required option, further hardware components (such as
interface modules) will be necessary.

Firmware
The firmware of version 21 can be used on the following hardware
platforms:

Hardware type
MTC-P01.2-xxx
MTC-R01.1-xxx
MTC-R02.1-xxx
MTS-P01.2-xx-xxx
MTS-P02.2-xx-xxx

MTS-R01.2-M1-xxx
MTS-R02.2-M1-xxx

TRANS-R01.2

Fig. 1-2: Supported hardware types

Software requirements
The user interface of the software and firmware version 21VRS for the
system200 can only be operated under Windows NT 4.0.
For Windows NT 4.0, service pack 5 or higher is required.
The installation program checks whether the required service pack has
been installed!
Furthermore the Microsoft Internet Explorer 4.01 SP2 or higher is
required.

Note: The corresponding service pack must again be activated if
additional operating system components (such as a network
driver) will subsequently be installed.

Rexroth Indramat supplies Version 21VRS only in conjunction with
Windows NT 4.0.
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1.3 Before You Start Installing the User Interface
If you have ordered a completely configured BTV20 unit with control
modules, the user interface and the related firmware have already been
installed when the unit is delivered. The following values are invariably
entered during the installation process:

The following values are set for the interface data:
• Channel Online
• I/O address: $31C
• Memory address: $D000:$0000

For user access the following values are set:
Windows NT access:
• User name: indramat
• Pass word: indramat

User interface:
• User name: Supervisor
• Pass word: 123

For the pre-installed BTV you only need the following chapters for
updating the software. The user interface must be installed according to
the following description if you use the BTV or a third-party PC with
external control hardware or if you want to use the MTC-P and MTS-P
control modules in a third-party PC.

Note: In order to function properly, the software version of the user
interface and the firmware version of the
MTC200/ISP200/TRANS200 must match. Before installing the
user interface or to updating an existing installation, check
whether the corresponding firmware version which is to be
operated with the interface is available. After the installation,
the firmware can be transferred into the control by executing
firmware download.
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2 Execute Setup

2.1 Administration Rights
⇒ For Windows NT 4.0 system settings and the installation of the

interface, administrator rights are necessary.
BTVs delivered by Rexroth Indramat have the following access data:
• User name: indramat
• Codeword: indramat

Log on as Administrator
When the BTV is delivered the default setting includes that Windows NT
4.0 is started automatically and the user logs on with the standard user
name "indramat". The boot process must be interrupted for logging on as
administrator.
⇒ Keep one of the two shift keys pressed during the boot process.

The log on dialog "log on information" is displayed.
Log on as administrator.
• User name: Administrator
• Codeword: indramat

2.2 Network Services
If you have installed the network services that are provided by Windows
NT 4.0 without actually being connected to a network, there will be a long
waiting time (approximately 2-5 seconds) when you change menus. This
is caused by system-internal time-outs. There are two possibilities to
solve this problem:
⇒ Uninstall the network services according to the Windows NT 4.0

system description
- or -

⇒ Use two hardware profiles (with and without network services)
according to the Windows NT 4.0 system description. This will cause
an option menu to be displayed upon the next system start from
which you can select a configuration with or without network services.
With pre-installed BTVs a second hardware profile for network
operation is available.

Pre-installed BTVs
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2.3 First-Time Installation of the MTGUI

CD ROM
The MTGUI software is delivered on CD only. Therefore a CD ROM drive
or network connection must be available for setup.

Local CD ROM disk drive
For installation, a portable CD ROM disk drive can be connected to the
parallel port of the BTV.

��
���

�

������������	


��
Cd-rom.FH7

Fig. 2-1: Locally connected CD ROM disk drive

CD ROM disk drive in a network
If the BTV is connected to a network, the CD ROM disk drive of a PC
included in the net can be used for installation.
1. Set up the Microsoft network.
2. Release the CD ROM disk drive of the connected PC.

	�����	

������

Netz.FH7

Fig. 2-2: CD ROM disk drive in a network

Execute Setup
In this description we assume that you use CD ROM drive "E" for the
installation.
1. Insert the CD-ROM into the CD-ROM drive of your PC.
2. Click on Execute in the start menu.
3. Type the letter for the drive together with ":\SETUP.EXE".
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When you install your system from a CD-ROM, type, for example:
"E:\SETUP.EXE".

set01.pcx

Fig. 2-3: Windows NT 4.0 “Execute” dialog

4. Then, click OK or confirm with <Enter>.
5. Select the language for the setup program.
The installation program is loaded.

set02.tif

Fig. 2-4: The installation program is loaded.

Follow the following installation instructions now. Confirm with Yes or
Continue until the selection "User Information" is displayed.

Note: Please note the readme file that may be displayed. It includes
the latest information that had not been available when this
documentation was published.
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set03.bmp

Fig. 2-5: Company information and serial number

6. Enter name and company of the rightful user.
7. Enter the serial number of the software and confirm with Next.

set04.bmp

Fig. 2-6: Disk drive and destination path

8. In the next dialog select the drive and the destination path where the
interface is to be installed.

Note: The hard disk in a standard BTV is divided into two partitions
(C: FAT file system, D: NTFS file system). The interface must
be installed on drive D: for safety reasons.
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9. Follow the further instructions of the setup program until you are
prompted to enter the folder for the program symbols.

10. Enter a name for a new program folder or select an existing folder.

Note: Ensure that you do not select the Autostart group. User
interface and system configurator cannot be started
simultaneously.

11. Start the copy process by clicking Next or return to the previous
dialogs by clicking Back.

The copy process will be started now. The progress of the installation will
be displayed in a progress bar.

After the copy process you will be prompted to restart Windows.

Note: You must restart Windows and/or your computer before you
can use the program.

After initialization, the system files are updated and the required
registrations are performed. A window with progress bars is displayed. No
entries are necessary.
Then the installation is finished. The system configurator will be started
automatically.
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2.4 Further Steps Before First Operation

System configuration
Before the control is used for the first time, the system must be
configured. The system configurator determines which devices are
connected to the control PC, the status they have and the communication
ways that are used by the devices. Please refer to chapter 3 System
Configuration.

Note: After the first time installation of the MTGUI the system
configurator will be started automatically when the interface is
started. The system configurator can be called with the
desktop icon or in the start menu in order to make further
modifications of the configuration.

Load Firmware/SPS Program
After the installation of the interface it is necessary to update the
firmware. For this, refer to the documentation "Setup, DOK-CONTRL-
SETUP***Vxx-AW0x-DE-P".
Also the SPS program must be loaded into the control.

Note: TRANS200: Loading the SPS program is not executed with
TRANS200.

Proceed as follows:
• Load firmware
• Load parameters
• Load SPS program (MTC200/ISP200 only)
• Load I/O configuration (TRANS200 only)
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2.5 Updating the MTGUI
The software can be updated with the setup program.

Note: It is recommended to save the user data prior to updating the
software!

1. Insert the installation CD in the drive and execute the setup program
of the new software version.

2. Choose the installation language and answer the dialogs about the
readme file and the license agreement.
The setup program will recognize the current software version and will
display it as follows.

akt_01.bmp

Fig. 2-7: Information about the currently installed software version

The Next button will take you to the installation options.
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akt_02.bmp

Fig. 2-8: Selection of type of installation

3. Choose updating an installed system in the dialog shown above and
press Next.
Now the installation of the update will begin. The progress of the
installation will be displayed in a progress bar.

After the copy process you will be prompted to restart Windows.

Note: You must restart Windows and/or your computer before you
can use the program.

After restart the system files are updated. Then the update installation is
finished.
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2.6 Uninstalling the MTGUI
The user interface can be uninstalled with the setup program.

CAUTION

Loss of user data!
⇒ Make sure that you save the user data before

uninstalling the software if you want to keep them.

1. Insert the installation CD in the drive and execute the setup program.
2. Choose the installation language and answer the dialogs about the

readme file and the license agreement.
The setup program will recognize the current software version and will
display it as follows.

deinst_01.bmp

Fig. 2-9: Information about the currently installed software version

The Next button will take you to the installation options.
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deinst_02.bmp

Fig. 2-10: Selection of type of installation

3. Choose uninstalling an installed system in the dialog shown above
and press Next.

4. Answer the safety prompt with Yes if you want to delete the
application; answer with No if you don’t want to delete the application.

deinst_03.bmp

Fig. 2-11: Safety prompt for deletion of the system

This starts the deinstallation. The progress will be displayed in a
progress bar.

After the process you will be prompted to restart Windows.

Note: In order to update the system files, the computer/Windows
must be restarted.

After restart the system files are updated. Then the deinstallation is
finished.
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3 System Configuration

3.1 General View of the System Configurator

Field of application
The System Configurator is an editor which is used to describe the
devices connected to the Control PC. The device address, the device type
and the description of the communication path to the unit are employed
for this purpose. The goal is to create an 1:1 image of the unit structure
(known as the system configuration) that is connected to the controller
PC. The system configuration is stored in the controller PC.
The System Configurator is used by the Function Interface and the User
Interface (MTGUI) for the organization of the communication with the
devices connected to the Control PC.

Menu Structure and Data Input
The left-hand half of the screen contains a graphical representation of the
configured units in a tree diagram. For the device which is selected in the
tree the corresponding data is displayed on the right side of the screen.

When entering data, e. g. when creating a new device, or when editing an
existing device, the user will be guided by an assistant. The assistant
splits the data entry into several steps.

SystemConfiguration.bmp

Fig. 3-1: System Configurator with two devices

Installation and Start of the System Configurator
The System Configurator is installed when installing the MTGUI. The
System Configurator will be started automatically after the installation.

Menu structure

Data input
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Note: The System Configurator is an independent program and must
be started at least once before starting the MTGUI. The
System Configurator and the user interface can’t be active at
the  same time. The System Configurator also has to be
finished before starting the MTGUI.

The setup program creates a link to the System Configurator on the
desktop. At the same time a link will be added in the program folder
Indramat of the start menu. In both possibilities the System Configurator
will be started directly by the program call Syscon.exe.

Typical scenario

If for example an MTC200-R-G2, address 0 selected at the selector
switch, is connected via RS232 to COM2 of the Control PC, this
configuration has to be entered in the System Configurator. That means a
device of the type MTC200-R-G2, Device Address 0, with a
Communication Address that includes the settings RS232 and COM2
etc..

If the physical configuration of a device is changed, the device must be
adjusted/edited in the System Configurator. If for example the connection
of device 0 to the Control PC is modified from COM2 to COM1, the device
0 has to be edited in the System Configurator. This means COM1 has to
be selected instead of COM2 as the Channel in the corresponding
Communication Address.

Connect a New Device

Modify an existing device
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3.2 Information on the System Configurator

Device type
The device types available in the current installation of the System
Configuration are shown in the selection box "Device Type" in the first
step of the function "New Device" (see step 1).
The following list shows device types which are available depending on
the installation.

Device type Class Description
MTVNC MTCX Virtual MTC
MTC200-P-G2 MWCX MTC with SPS PC variation
MTC200-R-G2 MWCX MTC with SPS PECO variation
MTA200-P-G2 MTAX MTA with WIN-SPS PC variation
ISP200-P-G2 MWSX Standalone-WIN-SPS PC variation
ISP200-R-G2 MWSX Standalone-WIN-SPS RECO variation
SYNAX200-P MSYX SYNAX as PC variation
SYNAX200-R MSYX SYNAX as RECO variation
SERCANS-A MSCX SCS-A-card
SERCANS-P MSCX SCS-P-card
TRA200-R MTRX TRANS200 as RECO variation
ECODRIVE03 MECX ECODRIVE03

Fig. 3-2: Types and classes of devices

Device / Device Address
With a device e. g. a control hardware or a drive device is meant.
The value range for entering the device address is 0 to 63.

Checking the free serial interfaces
A check of the free serial ports is done. Occupied serial ports (e. g.
mouse) will not be offered for editing Communication Addresses in the
System Configurator.
The check can be disabled (Menu Options, Entry  Show only free COM
ports).
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Communication Address
The Communication Address is a Rexroth Indramat specific data set
which describes the way of communication to the device. The
Communication Address has a symbolic identifier which consists of the fix
part CommAddr and a number, e. g. CommAddr2. Up to 8
Communication Addresses can be created (CommAddr1 to
CommAddr8).

Note: Devices which are connected to the same serial port have the
same communication address.

Updating the Directory Structure
When saving the system configuration data, an update of the directory
structure will be executed if necessary. The update of the directories will
only be executed if devices have been deleted or new devices have been
added.

File Menu
The File Menu offers the menu items Save and Exit.
The system configuration will be saved.

If modifications have been made, you will be asked by a MSG-BOX
whether to save and exit or exit without saving.

Options Menu
Refer to 3.2 Information on the System Configurator Checking the free
serial interfaces.

The server which is required for interconnection will be started the next
time the interface is started.

The device interrogation cycle will be activated or deactivated. I.e. the
device status (error status, device online, ...) will be checked permanently
in active state.
Furthermore, it is possible to determine how often the interrogation is
executed.

Save

Exit

List free ports

Network active

Device interrogation cycle



Installation 21VRS System Configuration 3-5

DOK-CONTRL-INS*BOF*V21-AW01-EN-P

3.3 Available Functions

Overview

Menüauswahl.bmp

Fig. 3-3: Edit menu options

The functions can be called in the Edit menu with the menu items New,
Edit, Paste, Copy, Delete, Cut, Shift Device Up, Shift Device Down or
with the toolbar button where the command is assigned.

Note: The underlined words correspond to the function designations
in the Edit menu.

The command New has the effect that this new device will be inserted
before the device which is currently selected in the tree.
The content of the functions create new device, edit device and insert
device (refer to 3.2, 3.3 and 3.8) depends on the device type. The
following tables provide a short overview for this functions.

Create a New
Device

Devices except MTVNC MTVNC

Step 1 Select device type Select device type
Step 2 Select device address Select device address
Step 3 Enter device name and

device status
Enter device name and
device status

Step 4 Select component type 1/2 No selection
Step 5 Edit communication address Configuration of the MTVNC

(start mode, memory size)

Fig. 3-4: Steps for “Create new device”
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Edit Device Devices except MTVNC MTVNC
Step 1 Enter device name and

device status
Enter device name and
device status

Step 2 Select component type 1/2 No selection
Step 3 Edit communication address Configuration of the MTVNC

(start mode, memory size)

Fig. 3-5: Steps for “Edit device”

Insert Device Devices except MTVNC MTVNC
Step 1 Select device address Select device address
Step 2 Enter device name and

device status
Enter device name and
device status

Step 3 Select component type 1/2 No selection
Step 4 Edit communication address Configuration of the MTVNC

(start mode, memory size)

Fig. 3-6: Steps for “Insert device”

Create a New Device

The function can be called in the Edit Menu, via the menu item New
Device, or via the toolbar button for New Device. The new device is
inserted ahead of the device currently marked in the tree.
When entering data the user will be guided by an assistant. The assistant
splits the data entry into several steps. The creation of a new device will
be finished using the button Finish in the last Step.

Menüauswahl_neu.bmp

Fig. 3-7: Menu selection
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Create a new device, step 1

The device type is selected in this step. The device type must correspond
to the connected control PC.

Note: The device type cannot be changed after it has been created.

Create a new device, step 2

The device address is selected in this step.
If the device is connected to the Control PC by a serial connection and
has a selector switch, the Device Address has to correspond to the
address selected at the device by the selector switch.

Note: The device address has to be unambiguous.
The device address cannot be changed after it has been
created.

Create a new device, step 3

The device name is entered and the device status is selected. The device
name may comprise up to 32 characters and should not include special
characters.

Note: Set the device status to ON if the device exists and is ready,
else to OFF.

Create a new device, step 4

The component type is selected in this step. With the key combination
ALT + ↓ the selection list can be opened.

Create a new device, step 5

A Communication Address is assigned to the device. First a
Communication Address has to be selected in the selection box Comm.
Address.
In the selection box only Communication Addresses will be offered which
correspond to the Device Type of the currently edited device and which
have not yet been used by other devices. Exceptions are devices which
are connected by a serial port. Please see also the note below.
If no Communication Address exists yet, it has to be created by using the
entry New in the selection box, or via the toolbar button New
Communication Address.

Devices except MTVNC
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The data of the Communication Address depends on the Device Type
and is displayed in the corresponding entry fields. The data has to
correspond to the device settings.
⇒  For further information on the devices please refer to the Technical

Documentation of the device.

Note: If devices are connected to the Control PC by a serial
connection, it is possible that several devices use the same
communication path (the same Communication Address) e.g.
when using the RS485 protocol. The devices are addressed
by the Device Address (user address) selected via the selector
switch.

For devices of the type MTVNC the configuration of the MTVNC is done
in this step.

The Start Mode of the MTVNC is selectable:
• ON: The MTVNC is started when starting the MUI/GUI.
• OFF: The MTVNC is not started.

Note: If the device status is ON, the start mode MTVNC of the
device is automatically set to ON. The start mode of the
MTVNC can only be modified if the device status is OFF.

The memory of the computer which is used by the MTVNC can be
adjusted:
• Preassignment: 512KB
• Value range:from 256KB to 16383KB in steps of 1 KB

With the button ”Extended” the ”Options” can be accessed. The options
are not needed under normal use.

Note: For the entry Options, data may only be entered according to
prior agreement with Rexroth Indramat staff. Normally no data
is entered!

MTVNC
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Edit Device
The device to be edited has to be selected in the 'System Configuration'
tree.
By <Enter> or DOUBLECLICK on the selected device or via the Edit
Menu, entry Edit Device as well as via the toolbar button for Edit Device,
the editing of the device can be started.

Menüauswahl_bearb.bmp

Fig. 3-8: Menu selection

The user will be guided by an assistant through editing the data. The
assistant splits the data entry into several steps. The function Edit Device
will be finished using the button Finish in the last step.

Note: Neither the Device Address nor the Device Type can be
changed.

Edit device, Step 1
The device name is entered and the device status is selected. The device
name may comprise up to 32 characters and should not include special
characters.

Note: Set the device status to ON if the device exists and is ready,
else to OFF.

Edit device, Step 2

The component type is selected in this step. With the key combination
ALT + ↓ the selection list of allowed combinations can be opened.
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Edit device, Step 3
The Communication Address data can be modified and a new
Communication Address can be created. Furthermore, the
Communication Address currently assigned to a device can be changed.
The Communication Address selected in the selection box Comm.
Address is assigned to the device.
In the selection box only Communication Addresses will be offered which
correspond to the Device Type of the currently edited device and which
have not yet been used by other devices. Exceptions are devices which
are connected by a serial port. Please see also the note below.
The data of the Communication Address depends on the Device Type
and is displayed in the corresponding entry fields. The data has to
correspond to the device settings. For further information on the devices
please refer to the Technical Documentation of the device.

Note: If devices are connected to the Control PC by a serial
connection, it is possible that several devices use the same
communication path (the same Communication Address) e.g.
when using the RS485 protocol. The devices are addressed
by the Device Address (user address) selected via the selector
switch.

For devices of the type MTVNC the configuration of the MTVNC is done
in this step.

The start mode of the MTVNC is selectable:
• ON: The MTVNC is started when starting the MUI/GUI.
• OFF: The MTVNC is not started.

Note: If the device status is ON, the start mode MTVNC of the
device is automatically set to ON. The start mode of the
MTVNC can only be modified if the device status is OFF.

The memory of the computer which is used by the MTVNC can be
adjusted:
• Preassignment: 512KB
• Value range: from 256KB to 16383KB in steps of 1 KB

With the button ”Extended” the ”Options” can be accessed. The options
are not needed under normal use.

Note: For the entry Options, data may only be entered according to
prior agreement with Rexroth Indramat staff. Normally no data
is entered!

Delete Device
The device which is to be deleted has to be selected in the tree 'System
Configuration'.
Via the Edit Menu, entry Delete Device or via the toolbar button for
Delete Device, as well as via the <Del> key of the keyboard the selected
device is deleted. Then a confirmation prompt appears.

Devices except MTVNC

MTVNC
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Note: By deleting a device the data in the directory of this device will
also be deleted.

Cut Devices
The device which is to be cut has to be selected in the tree 'System
Configuration'.
Via the Edit Menu, entry Cut Device or via the toolbar button for Cut
Device the selected device will be deleted, and copied into a temporary
buffer. Then a confirmation prompt appears.

Copy Device
The device which is to be copied has to be selected in the tree 'System
Configuration'.
Via the Edit Menu, entry Copy Device or via the toolbar button for Copy
Device the selected device will be copied into a temporary buffer.

Paste Device
If a device is saved in the temporary buffer, it can be inserted via the
function Paste Device. The device will be inserted ahead of the device
currently selected in the tree 'System Configuration'.
The user must enter a device address when the device is inserted.
Further settings can be modified if required. The user will be guided by an
assistant. The following general procedure is valid:
• In Step 1 of Insert Device, the Device Address is assigned (refer to

'Create a New Device').
From Step 2 on, the steps as known from editing an already available
device are used.
• In Step 2 the Device Name and the Device Status can be edited.
• In Step 3 the component type 1/2 will be chosen.
• In Step 4 the Communication Address can be edited or the MTVNC

can be configured.

Note: Copy / Cut / Paste includes the System Configuration data of
the device (Device Type etc.). It does not include data like NC-
programs, message texts etc. which are located in the device
directories.
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Move Device upwards
The device which is to be shifted has to be selected in the tree 'System
Configuration'.
Via the Edit Menu, entry Shift Device Up or via the toolbar button for
Shift Device Up, the selected device is shifted one entry up in the tree.

Move Device upwards
The device which is to be shifted has to be selected in the tree 'System
Configuration'.
Via the Edit Menu, entry Shift Device Down or via the toolbar button for
Shift Device Down, the selected device is shifted one entry down in the
tree.
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6 Service & Support

6.1 Helpdesk
Unser Kundendienst-Helpdesk im Hauptwerk Lohr
am Main steht Ihnen mit Rat und Tat zur Seite.
Sie erreichen uns

- telefonisch: +49 (0) 9352 40 50 60
über Service Call Entry Center Mo-Fr   07:00-18:00

- per Fax: +49 (0) 9352 40 49 41

- per e-Mail: service@indramat.de

Our service helpdesk at our headquarters in Lohr am
Main, Germany can assist you in all kinds of inquiries.
Contact us

- by phone: +49 (0) 9352 40 50 60
via Service Call Entry Center Mo-Fr 7:00 am - 6:00 pm

- by fax: +49 (0) 9352 40 49 41

- by e-mail: service@indramat.de

6.2 Service-Hotline
Außerhalb der Helpdesk-Zeiten ist der Service
direkt ansprechbar unter

+49 (0) 171 333 88 26
oder +49 (0) 172 660 04 06

After helpdesk hours, contact our service
department directly at

+49 (0) 171 333 88 26
or +49 (0) 172 660 04 06

6.3 Internet

Unter www.indramat.de finden Sie
ergänzende Hinweise zu Service, Reparatur und
Training sowie die aktuellen Adressen *) unserer
auf den folgenden Seiten aufgeführten Vertriebs-
und Servicebüros.

Verkaufsniederlassungen
Niederlassungen mit Kundendienst

Außerhalb Deutschlands nehmen Sie bitte zuerst Kontakt mit
unserem für Sie nächstgelegenen Ansprechpartner auf.

*) http://www.indramat.de/de/kontakt/adressen
Die Angaben in der vorliegenden Dokumentation können
seit Drucklegung überholt sein.

At www.indramat.de you may find additional
notes about service, repairs and training in the
Internet, as well as the actual addresses *) of our
sales- and service facilities figuring on the following
pages.

sales agencies
offices providing service

Please contact our sales / service office in your area first.

*) http://www.indramat.de/en/kontakt/adressen
Data in the present documentation may have become
obsolete since printing.

6.4 Vor der Kontaktaufnahme... - Before contacting us...
Wir können Ihnen schnell und effizient helfen wenn
Sie folgende Informationen bereithalten:
1. detaillierte Beschreibung der Störung und der

Umstände.
2. Angaben auf dem Typenschild der betreffenden

Produkte, insbesondere Typenschlüssel und
Seriennummern.

3. Tel.-/Faxnummern und e-Mail-Adresse, unter
denen Sie für Rückfragen zu erreichen sind.

For quick and efficient help, please have the
following information ready:
1. Detailed description of the failure and

circumstances.
2. Information on the type plate of the affected

products, especially type codes and serial
numbers.

3. Your phone/fax numbers and e-mail address,
so we can contact you in case of questions.

http://www.indramat.de/en/kontakt/adressen
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6.5 Kundenbetreuungsstellen - Sales & Service Facilities

Deutschland – Germany vom Ausland: (0) nach Landeskennziffer weglassen!
from abroad: don’t dial (0) after country code!

Vertriebsgebiet Mitte
 Germany Centre

Rexroth Indramat GmbH
Bgm.-Dr.-Nebel-Str. 2 / Postf. 1357
97816 Lohr am Main / 97803 Lohr

Kompetenz-Zentrum Europa

Tel.: +49 (0)9352 40-0
Fax: +49 (0)9352 40-4885

S E R V I C E
C A L L  E N T R Y  C E N T E R
MO – FR

von 07:00 - 18:00 Uhr

from 7 am – 6 pm

Tel. +49 (0) 9352 40 50 60
service@indramat.de

S E R V I C E
HOTLINE
MO – FR

von 17:00 - 07:00 Uhr
from 5 pm - 7 am

+ SA / SO

Tel.: +49 (0)172 660 04 06
oder  /  o r

Tel.: +49 (0)171 333 88 26

S E R V I C E
ERSATZTEILE / SPARES

verlängerte Ansprechzeit
- extended office time -

♦ nur an Werktagen
- only on working days -

♦ von 07:00 - 18:00 Uhr
- from 7 am - 6 pm  -

Tel. +49 (0) 9352 40 42 22

Vertriebsgebiet Süd
 Germany South

Rexroth Indramat GmbH
Landshuter Allee 8-10
80637 München

Tel.: +49 (0)89 127 14-0
Fax: +49 (0)89 127 14-490

Gebiet Südwest
 Germany South-West

Bosch Rexroth AG
Vertrieb Deutschland – VD-BI
Geschäftsbereich Rexroth Indramat
Regionalzentrum Südwest
Ringstrasse 70    /   Postfach 1144
70736 Fellbach   /    70701 Fellbach
Tel.: +49 (0)711 57 61–100
Fax: +49 (0)711 57 61–125

Vertriebsgebiet Ost
 Germany East

Bosch Rexroth AG
Beckerstraße 31
09120 Chemnitz

Tel.: +49 (0)371 35 55-0
Fax: +49 (0)371 35 55-333

Vertriebsgebiet Ost
 Germany East

Bosch Rexroth AG
Regionalzentrum Ost
Walter-Köhn-Str. 4d
04356 Leipzig

Tel.: +49 (0)341 25 61-0
Fax: +49 (0)341 25 61-111

Vertriebsgebiet West
 Germany West

Bosch Rexroth AG
Vertrieb Deutschland
Regionalzentrum West
Borsigstrasse 15
40880 Ratingen
Tel.: +49 (0)2102 409-0
Fax: +49 (0)2102 409-406

Vertriebsgebiet Mitte
 Germany Centre

Bosch Rexroth AG
Regionalzentrum Mitte
Waldecker Straße 13
64546 Mörfelden-Walldorf

Tel.: +49 (0) 61 05 702-3
Fax: +49 (0) 61 05 702-444

Vertriebsgebiet Nord
 Germany North

Bosch Rexroth AG
Walsroder Str. 93
30853 Langenhagen

Tel.: +49 (0) 511 72 66 57-0
Service: +49 (0) 511 72 66 57-256
Fax: +49 (0) 511 72 66 57-93
Service: +49 (0) 511 72 66 57-95

Vertriebsgebiet Nord
 Germany North

Bosch Rexroth AG
Kieler Straße 212
22525 Hamburg

Tel.: +49 (0) 40 81 955 966
Fax: +49 (0) 40 85 418 978

mailto:service@indramat.de
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Europa (West) - Europe (West)

vom Ausland: (0) nach Landeskennziffer weglassen, Italien: 0 nach Landeskennziffer mitwählen
from abroad:    don’t dial (0) after country code, Italy:    dial 0 after country code

Austria - Österreich

Bosch Rexroth GmbH
Bereich Indramat
Stachegasse 13
1120 Wien
Tel.: +43 (0)1 985 25 40
Fax: +43 (0)1 985 25 40-93

Austria – Österreich

Bosch Rexroth G.m.b.H.
Gesch.ber. Rexroth Indramat
Industriepark 18
4061 Pasching
Tel.: +43 (0)7221 605-0
Fax: +43 (0)7221 605-21

Belgium - Belgien

Bosch Rexroth AG
Electric Drives & Controls
Industrielaan 8
1740 Ternat
Tel.: +32 (0)2 5830719
- service: +32 (0)2 5830717
Fax: +32 (0)2 5830731
 indramat@boschrexroth.be

Denmark - Dänemark

BEC A/S
Zinkvej 6
8900 Randers

Tel.: +45 (0)87 11 90 60
Fax: +45 (0)87 11 90 61

Great Britain – Großbritannien

Bosch Rexroth Ltd.
Rexroth Indramat Division
Broadway Lane, South Cerney
Cirencester, Glos GL7 5UH

Tel.: +44 (0)1285 863000
Fax: +44 (0)1285 863030
 sales@boschrexroth.co.uk
 service@boschrexroth.co.uk

Finland - Finnland

Bosch Rexroth Oy
Rexroth Indramat division
Ansatie 6
017 40 Vantaa

Tel.: +358 (0)9 84 91-11
Fax: +358 (0)9 84 91-13 60

France - Frankreich

Bosch Rexroth S.A.
Division Rexroth Indramat
Avenue de la Trentaine
BP. 74
77503 Chelles Cedex
Tel.: +33 (0)164 72-70 00
Fax: +33 (0)164 72-63 00
Hotline: +33 (0)608 33 43 28

France - Frankreich

Bosch Rexroth S.A.
Division Rexroth Indramat
1270, Avenue de Lardenne
31100 Toulouse

Tel.: +33 (0)5 61 49 95 19
Fax: +33 (0)5 61 31 00 41

France - Frankreich

Bosch Rexroth S.A.
Division Rexroth Indramat
91, Bd. Irène Joliot-Curie
69634 Vénissieux – Cedex
Tel.: +33 (0)4 78 78 53 65
Fax: +33 (0)4 78 78 53 62

Italy - Italien

Bosch Rexroth S.p.A.
Via G. Di Vittoria, 1
20063 Cernusco S/N.MI

Tel.: +39 02 2 365 270
Fax: +39 02 700 408 252378

Italy - Italien

Bosch Rexroth S.p.A.
Via Paolo Veronesi, 250
10148 Torino

Tel.: +39 011 224 88 11
Fax: +39 011 224 88 30

Italy - Italien

Bosch Rexroth S.p.A.
Via del Progresso, 16 (Zona Ind.)
35020 Padova

Tel.: +39 049 8 70 13 70
Fax: +39 049 8 70 13 77

Italy - Italien

Bosch Rexroth S.p.A.
Via Mascia, 1
80053 Castellamare di Stabia NA

Tel.: +39 081 8 71 57 00
Fax: +39 081 8 71 68 85

Italy - Italien

Bosch Rexroth S.p.A.
Viale Oriani, 38/A
40137 Bologna

Tel.: +39 051 34 14 14
Fax: +39 051 34 14 22

Netherlands – Niederlande/Holland

Bosch Rexroth B.V.
Kruisbroeksestraat 1
(P.O. Box 32)
5281 RV Boxtel
Tel.: +31 (0)411 65 19 51
Fax: +31 (0)411 65 14 83
 indramat@hydraudyne.nl

Netherlands - Niederlande/Holland

Bosch Rexroth Services B.V.
Kruisbroeksestraat 1
(P.O. Box 32)
5281 RV Boxtel
Tel.: +31 (0)411 65 19 51
Fax: +31 (0)411 67 78 14

Norway - Norwegen

Bosch Rexroth AS
Rexroth Indramat Division
Berghagan 1          or: Box 3007
1405 Ski-Langhus     1402 Ski

Tel.: +47 (0)64 86 41 00
Fax: +47 (0)64 86 90 62
 jul.ruud@rexroth.no

Spain - Spanien

Bosch Rexroth S.A.
Divisiòn Rexroth Indramat
Centro Industrial Santiga
Obradors s/n
08130 Santa Perpetua de Mogoda
Barcelona
Tel.: +34 9 37 47 94 00
Fax: +34 9 37 47 94 01

Spain – Spanien

Goimendi S.A.
División Rexroth Indramat
Parque Empresarial Zuatzu
C/ Francisco Grandmontagne no.2
20018 San Sebastian

Tel.: +34 9 43 31 84 21
- service: +34 9 43 31 84 56
Fax: +34 9 43 31 84 27
- service: +34 9 43 31 84 60
 sat.indramat@goimendi.es

Sweden - Schweden

Rexroth Mecman Svenska AB
Rexroth Indramat Division
- Varuvägen 7
(Service: Konsumentvägen 4, Älfsjö)
125 81 Stockholm

Tel.: +46 (0)8 727 92 00
Fax: +46 (0)8 647 32 77

Sweden - Schweden

Rexroth Mecman Svenska AB
Indramat Support
Ekvändan 7
254 67 Helsingborg
Tel.: +46 (0) 42 38 88 -50
Fax: +46 (0) 42 38 88 -74

Switzerland West - Schweiz West

Bosch Rexroth Suisse SA
Département Rexroth Indramat
Rue du village 1
1020 Renens
Tel.: +41 (0)21 632 84 20
Fax: +41 (0)21 632 84 21

Switzerland East - Schweiz Ost

Bosch Rexroth Schweiz AG
Geschäftsbereich Indramat
Hemrietstrasse 2
8863 Buttikon
Tel. +41 (0) 55 46 46 111
Fax +41 (0) 55 46 46 222

mailto:sales@indramat.co.uk
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Europa (Ost) - Europe (East)

vom Ausland: (0) nach Landeskennziffer weglassen  
from abroad:    don’t dial (0) after country code

Czech Republic - Tschechien

Bosch -Rexroth, spol.s.r.o.
Hviezdoslavova 5
627 00 Brno
Tel.: +420 (0)5 48 126 358
Fax: +420 (0)5 48 126 112

Czech Republic - Tschechien

DEL a.s.
Strojírenská 38
591 01 Zdar nad Sázavou
Tel.: +420 616 64 3144
Fax: +420 616 216 57

Hungary - Ungarn

Bosch Rexroth Kft.
Angol utca 34
1149 Budapest
Tel.: +36 (1) 364 00 02
Fax: +36 (1) 383 19 80

Poland – Polen

Bosch Rexroth Sp.zo.o.
ul. Staszica 1
05-800 Pruszków
Tel.: +48 22 738 18 00
– service: +48 22 738 18 46
Fax: +48 22 758 87 35
– service: +48 22 738 18 42

Poland – Polen

Bosch Rexroth Sp.zo.o.
Biuro Poznan
ul. Dabrowskiego 81/85
60-529 Poznan
Tel.: +48 061 847 64 62 /-63
Fax: +48 061 847 64 02

Rumania - Rumänien

Bosch Rexroth Sp.zo.o.
Str. Drobety nr. 4-10, app. 14
70258 Bucuresti, Sector 2
Tel.: +40 (0)1 210 48 25

+40 (0)1 210 29 50
Fax: +40 (0)1 210 29 52

Russia - Russland

Bosch Rexroth
Wjatskaja ul. 27/15
125015 Moskau
Tel.: +7-095-785 74 78

+7-095 785 74 79
Fax: +7 095 785 74 77
 laura.kanina@boschrexroth.ru

Russia - Russland

ELMIS
10, Internationalnaya Str.
246640 Gomel, Belarus
Tel.: +375/ 232 53 42 70

+375/ 232 53 21 69
Fax: +375/ 232 53 37 69
 elmis_ltd@yahoo.com

Turkey - Türkei

Bosch Rexroth Otomasyon
San & Tic. A..S.
Fevzi Cakmak Cad No. 3
34630 Sefaköy Istanbul
Tel.: +90 212 541 60 70
Fax: +90 212 599 34 07

Slowenia - Slowenien

DOMEL
Otoki 21
64 228 Zelezniki
Tel.: +386 5 5117 152
Fax: +386 5 5117 225
 brane.ozebek@domel.si
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Africa, Asia, Australia – incl. Pacific Rim
vom Ausland: (0) nach Landeskennziffer weglassen!
from abroad: don’t dial (0) after country code!

Australia - Australien

AIMS - Australian Industrial
Machinery Services Pty. Ltd.
Unit 3/45 Horne ST
Campbellfield , VIC 3061
Melbourne
Tel.: +61 (0) 393 590 228
Fax: +61 (0) 393 590 286
Hotline: +61 (0) 419 369 195
 terryobrien@aimservices.com.au

Australia - Australien

Bosch Rexroth Pty. Ltd.
No. 7, Endeavour Way
Braeside Victoria, 31 95
Melbourne

Tel.: +61 (0)3 95 80 39 33
Fax: +61 (0)3 95 80 17 33
 mel@rexroth.com.au

China

Shanghai Bosch Rexroth
Hydraulics & Automation Ltd.
Wai Gao Qiao Free Trade Zone
No.122, Fu Te Dong Yi Road
Shanghai 200131 - P.R.China
Tel.: +86 21 58 66 30 30
Fax: +86 21 58 66 55 23
 roger.shi_sh@boschrexroth.com.cn

China

Bosch Rexroth (China) Ltd.
15/F China World Trade Center
1, Jianguomenwai Avenue
Beijing 100004, P.R.China

Tel.: +86 10 65 05 03 80
Fax: +86 10 65 05 03 79

China

Bosch Rexroth (China) Ltd.
A-5F., 123 Lian Shan Street
Sha He Kou District
Dalian 116 023, P.R.China

Tel.: +86 411 46 78 930
Fax: +86 411 46 78 932

China

Bosch Rexroth (Changzhou) Co.Ltd.
Guangzhou Repres. Office
Room 1014-1016, Metro Plaza,
Tian He District, 183 Tian He Bei Rd
Guangzhou 510075, P.R.China

Tel.: +86 20 8755-0030
+86 20 8755-0011

Fax: +86 20 8755-2387

Hongkong

Bosch Rexroth (China) Ltd.
6th Floor,
Yeung Yiu Chung No.6 Ind Bldg.
19 Cheung Shun Street
Cheung Sha Wan,
Kowloon, Hongkong
Tel.: +852 22 62 51 00
Fax: +852 27 41 33 44
alexis.siu@boschrexroth.com.hk

India - Indien

Bosch Rexroth (India) Ltd.
Rexroth Indramat Division
Plot. A-58, TTC Industrial Area
Thane Turbhe Midc Road
Mahape Village
Navi Mumbai - 400 701
Tel.: +91 (0)22 7 61 46 22
Fax: +91 (0)22 7 68 15 31

India - Indien

Bosch Rexroth (India) Ltd.
Rexroth Indramat Division
Plot. 96, Phase III
Peenya Industrial Area
Bangalore - 560058
Tel.: +91 (0)80 8 39 73 74
Fax: +91 (0)80 8 39 43 45
 rexbang@bgl.vsnl.net.in

Indonesia - Indonesien

PT. Rexroth Wijayakusuma
Building # 202, Cilandak
Commercial Estate
Jl. Cilandak KKO, Jakarta 12560

Tel.: +62 21 7891169 (5 lines)
Fax: +62 21 7891170 - 71

Japan

Bosch Rexroth Automation Corp.
Service Center Japan
Yutakagaoka 1810, Meito-ku,
NAGOYA 465-0035, Japan

Tel.: +81 (0)52 777 88 41
+81 (0)52 777 88 53
+81 (0)52 777 88 79

Fax: +81 (0)52 777 89 01

Japan

Bosch Rexroth Automation Corp.
Rexroth Indramat Division
1F, I.R. Building
Nakamachidai 4-26-44, Tsuzuki-ku
YOKOHAMA 224-0041, Japan
Tel.: +81 (0)45 942 72 10
Fax: +81 (0)45 942 03 41

Korea

Bosch Rexroth-Korea Ltd.
1515-14 Dadae-Dong, Saha-Ku
Rexroth Indramat Division
Pusan Metropolitan City, 604-050
Republic of South Korea

Tel.: +82 (0)51 26 00 741
Fax: +82 (0)51 26 00 747
 gyhan@rexrothkorea.co.kr

Malaysia

Bosch Rexroth Sdn.Bhd.
11, Jalan U8/82
Seksyen U8
40150 Shah Alam
Selangor, Malaysia
Tel.: +60 (0) 3 78 44 80 00
Fax: +60 (0) 3 78 45 48 00
 hockhwa@hotmail.com
 rexroth1@tm.net.my

Singapore - Singapur

Bosch Rexroth SDN BHD.
No.11, Jalan Astaka U8/82
Seksyen U8
40150 Shah Alam
Selangor Darul Ehsan

Tel.: +65 (0) 3 7844 8000
Fax: +65 (0) 3 7845 4800

 kenton.peh@boschrexroth.com.sg

South Africa - Südafrika

TECTRA Automation (Pty) Ltd.
71 Watt Street, Meadowdale
Edenvale 1609

Tel.: +27 (0)11 971 94 00
Fax: +27 (0)11 971 94 40
Hotline: +27 (0)82 903 29 23
 georgv@tectra.co.za

Taiwan

Rexroth Uchida Co., Ltd.
No.17, Lane 136, Cheng Bei 1 Rd.,
Yungkang, Tainan Hsien
Taiwan, R.O.C.

Tel.: +886 (0)6 25 36 565
Fax: +886 (0)6 25 34 754
 indramat@mail.net.tw

Thailand

NC Advance Technology Co. Ltd.
59/76 Moo 9
Ramintra road 34
Tharang, Bangkhen,
Bangkok 10230
Tel.: +66 2 943 70 62
        +66 2 943 71 21
Fax: +66 2 509 23 62
 sonkawin@hotmail.com

mailto:alexis.siu@boschrexroth.com.hk
mailto:hockhwa@hotmail.com
mailto:sonkawin@hotmail.com
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Nordamerika – North America
USA
Hauptniederlassung - Headquarters

Bosch Rexroth Corporation
Rexroth Indramat Division
5150 Prairie Stone Parkway
Hoffman Estates, IL 60192-3707

Tel.: +1 847 6 45 36 00
Fax: +1 847 6 45 62 01
servicebrc@boschrexroth-us.com
 repairbrc@boschrexroth-us.com

USA Central Region - Mitte

Bosch Rexroth Corporation
Rexroth Indramat Division
Central Region Technical Center
1701 Harmon Road
Auburn Hills, MI 48326

Tel.: +1 248 3 93 33 30
Fax: +1 248 3 93 29 06

USA Southeast Region - Südwest

Bosch Rexroth Corporation
Rexroth Indramat Division
Southeastern Technical Center
3625 Swiftwater Park Drive
Suwanee, Georgia 30124
Tel.: +1 770 9 32 32 00
Fax: +1 770 9 32 19 03

USA SERVICE-HOTLINE

- 7 days x 24hrs -

+1-800-860-1055

USA East Region –Ost

Bosch Rexroth Corporation
Rexroth Indramat Division
Charlotte Regional  Sales Office
14001 South Lakes Drive
Charlotte, North Carolina 28273

Tel.: +1 704 5 83 97 62
+1 704 5 83 14 86

USA Northeast Region – Nordost

Bosch Rexroth Corporation
Rexroth Indramat Division
Northeastern Technical Center
99 Rainbow Road
East Granby, Connecticut 06026

Tel.: +1 860 8 44 83 77
Fax: +1 860 8 44 85 95

USA West Region – West

Bosch Rexroth Corporation
7901 Stoneridge Drive, Suite 220
Pleasant Hill, California 94588

Tel.: +1 925 227 10 84
Fax: +1 925 227 10 81

Canada East - Kanada Ost

Bosch Rexroth Canada Corporation
Burlington Division
3426 Mainway Drive
Burlington, Ontario
Canada L7M 1A8

Tel.: +1 905 335 55 11
Fax: +1 905 335-41 84
 michael.moro@boschrexroth.ca

Canada West - Kanada West

Bosch Rexroth Canada Corporation
5345 Goring St.
Burnaby, British Columbia
Canada V7J 1R1

Tel. +1 604   205-5777
Fax +1 604   205-6944
 david.gunby@boschrexroth.ca

Mexico

Bosch Rexroth S.A. de C.V.
Calle Neptuno 72
Unidad Ind. Vallejo
07700 Mexico, D.F.

Tel.: +52 5 754 17 11
+52 5 754 36 84
+52 5 754 12 60

Fax: +52 5 754 50 73
+52 5 752 59 43

Mexico

Bosch Rexroth S.A. de C.V.
Calle Argentina No 3913
Fracc. las Torres
64930 Monterey, N.L.

Tel.: +52 8 333 88 34...36
+52 8 349 80 91...93

Fax: +52 8 346 78 71
mario.quiroga@boschrexroth.com.mx

Südamerika –  South America
Argentina - Argentinien

Bosch Rexroth S.A.I.C.
"The Drive & Control Company"
Acassusso 48 41/47
1605 Munro
Prov. Buenos Aires

Tel.: +54 (0)11 4756 01 40
Fax: +54 (0)11 4756 01 36
victor.jabif@boschrexroth.com.ar

Argentina - Argentinien

NAKASE
Servicio Tecnico CNC
Calle 49, No. 5764/66
1653 Villa Balester
Prov. - Buenos Aires

Tel.: +54 (0) 11 4768 36 43
Fax: +54 (0) 11 4768 24 13
 nakase@usa.net
 nakase@nakase.com
 gerencia@nakase.com (Service)

Brazil - Brasilien

Bosch Rexroth Ltda.
Av. Tégula, 888
Ponte Alta, Atibaia SP
CEP 12942-440

Tel.: +55 (0)11  4414 56 92
+55 (0)11  4414 56 84

Fax sales: +55 (0)11  4414 57 07
Fax serv.: +55 (0)11  4414 56 86
 alexandre.wittwer@rexroth.com.br

Brazil - Brasilien

Bosch Rexroth  Ltda.
R. Dr.Humberto Pinheiro Vieira, 100
Distrito Industrial    [Caixa Postal 1273]
89220-390 Joinville - SC

Tel./Fax: +55 (0)47 473 58 33
Mobil: +55 (0)47 9974 6645
 prochnow@zaz.com.br

Columbia - Kolumbien

Reflutec de Colombia Ltda.
Calle 37 No. 22-31
Santafé de Bogotá, D.C.
Colombia

Tel.: +57 1 368 82 67
+57 1 368 02 59

Fax: +57 1 268 97 37
reflutec@neutel.com.co

mailto:dave.gunby@basic.ca
mailto:dave.gunby@basic.ca
mailto:dave.gunby@basic.ca
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